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About BindView Corporation
About BindView 
Corporation

BindView Corporation is a leading provider of proactive business 
policy, IT security and directory management software worldwide. 
BindView solutions and services enable customers to centralize and 
automate policy compliance, vulnerability management, directory 
administration and migration across the entire organization. With 
BindView insight at work™, customers benefit from reduced risk 
and improved operational efficiencies with a verifiable return on 
investment. More than 20 million licenses have shipped to 5,000 
companies worldwide, spanning all major business segments and 
the public sector.

Online Documents Documentation is provided in the following electronic formats on 
the BindView product CD:

• Adobe® Acrobat® PDF files
• HTML Release Notes files
• Online help

Using PDF Files With Adobe Acrobat PDF files, you can navigate through a document 
quickly and perform full-text searches. In addition, the PDF files can 
be viewed online, distributed to multiple users electronically, or 
printed.

You must have Adobe® Reader® installed to read the PDF files.

To view PDF files, double-click PDF files to open them, and then 
move through the document by clicking topic headings in the left 
pane or green hypertext links in the text. To print copies, click Print 
from the File menu.

Installing Adobe Reader Adobe Reader installation programs for common operating systems 
are available for a free download from the Adobe Web site at 
www.adobe.com.

User Guides The Docs directory on the BindView product CD contains copies of 
the user guides and other documentation in the PDF format. 

The NETinventory User Guide contains information about 
NETinventory v8.00 and about the BindView RMS Console and 
Information Server v8.00. If you upgrade the BindView RMS 
Console and Information Server, the BindView RMS Console and 
Information Server User Guide included with the update will contain 
information about the new version of the Console.
10 NETinventory Console Getting Started Guide
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Release Notes
Release Notes If the autorun function is enabled, a Readme HTML file for your 
BindView product is accessible under the Documentation menu of 
the BindView setup menu when you insert your CD. You also can 
select to view this file after the installation is completed, or by 
browsing to the Release Notes directory in the root directory for 
your program:

C:\Program Files\BindView\RMS\Release Notes

Online Help Comprehensive help is available from the Help menu on the 
BindView RMS Console and the BindView RMS Web Console. 
Additionally, you can access help by clicking the Help button in 
any dialog, by right-clicking an item and selecting Help from the 
action menu, or by pressing F1 in any dialog.

Typestyle 
Conventions

The following conventions are observed throughout this guide:

• Bold text is used to designate file and folder names, dialog titles, 
names of buttons, icons, and menus, and terms that are objects 
of a user selection. 

• Italic text is used for word emphasis, defined terms, and manual 
titles.

• Monospace text (Courier) is used to show literal text as you 
would enter it, or as it would appear onscreen.

Alert Statements The alerting statements are Notes, Cautions, and Warnings. These 
statements are formatted in the following style:

Note: Information that is incidental to the main text flow, or to an 
important point or tip provided in addition to the previous 
statement or instruction.

Caution: Advises of machine or data error that could occur should 
the user fail to take or avoid a specified action.

Warning: Requires immediate action by the user to prevent actual 
loss of data or where an action is irreversible, or when physical 
damage to the machine or devices is possible.
Information Resources 11
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Contacting BindView
Contacting 
BindView

BindView has sales and support offices around the world. For 
information on contacting BindView, please refer to the information 
below or to the BindView Web site: www.bindview.com

For Technical Support: www.bindview.com/support

Technical Support is available Monday through Friday from 
7:00 a.m. to 7:00 p.m. Central Time. Normal working hours for all 
other departments are 9:00 a.m. to 6:00 p.m.

Phone

Sales and Customer 
Service

U.S. and Canada 800-813-5869

Outside N. America 713-561-4000

Technical Support U.S. and Canada 800-813-5867

Outside N. America 713-561-4000

Training/Professional 
Service

U.S. and Canada 800-749-8439

Outside N. America 713-561-4000

Fax All Areas 713-561-1000

E-mail

Sales sales@bindview.com

Training edu@bindview.com

Documentation docs@bindview.com

Other

FTP Site ftp://ftp.bindview.com

Internet www.bindview.com

Postal Mail BindView
5151 San Felipe, Suite 2500

Houston, TX 77056
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Overview
Overview NETinventory audits and manages information about PC 
workstations on LANs with Windows NT®, Windows® 2000, 
Windows Server™ 2003, and NetWare® servers.

This chapter guides you through installing the NETinventory 
Console and the NETinventory and NETrc snap-in modules on your 
local or network drive. 

System 
Requirements

This section describes the system requirements for the 
NETinventory Console, NETinventory, NETrc, the BindView RMS® 
Console and Information Server, and the NETinventory-RMS Snap-
in. 

NETinventory Console 
Workstation 
Requirements

To run NETinventory, machines with the NETinventory Console 
installed must meet the following minimum requirements: 

• Microsoft Windows NT® 4.0 SP6a (Server or Workstation), 
Windows® 2000 (Server or Professional), Windows XP® 
Professional, or Windows Server™ 2003. 

• Internet Explorer 5.5 or later
• Novell Client™ 4.8.3 SP1 or later (only required if there are 

NetWare Audit Servers)
• Client for Microsoft Networks

BindView RMS 
Console Requirements

If you wish to use the optional NETinventory Snap-in for the 
BindView RMS Console, your machine must meet the following 
minimum requirements: 

RMS Console

• Pentium® II 450 MHz, 256 MB RAM

• Windows 2000 SP2 (Server or Professional), Windows XP 
Professional, or Windows Server 2003

• 300 MB of free disk space 
• SVGA monitor that supports 256 colors with the display set to 800 

x 600 pixels
• Microsoft® Outlook® 2000, Novell® GroupWise® v5.5, Lotus 

Notes® v5.0 or Lotus Domino (only required for e-mail exporting)
• Microsoft Excel (required for Excel (using OLE) export files)
• Microsoft Internet Explorer 5.5 or later
• Client for Microsoft Networks
14 NETinventory Console Getting Started Guide
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NETinventory Server Requirements
RMS Information Server

• Pentium III 600 MHz, 512 MB RAM
• Windows 2000 SP2 (Server or Professional), Windows XP 

Professional, or Windows Server 2003
• 500 MB of free disk space
• Microsoft Outlook 2000, Novell GroupWise v5.5, Lotus Notes v5.0 

or Lotus Domino (only required for e-mail exporting)
• Microsoft Excel (required for Excel (using OLE) export files)
• Microsoft Internet Explorer 5.5 or later
• Microsoft SQL Server™ (v7.0 or 2000) or Microsoft SQL Server 

Desktop Engine (MSDE) (v1.0 or 2000)
• Client for Microsoft Networks

NETinventory Server 
Requirements

To collect NETinventory data from the machines on your network, 
you must install and configure at least one NETinventory server on 
a Windows NT Server, Windows 2000, Windows XP, or Windows 
Server 2003 machine. The machine will host a combined Master, 
Audit, and Login server. If you choose, you can create additional 
Audit and Login servers. More detailed information on this topic is 
included in Chapter 2, “NETinventory Setup” of this Getting Started 
Guide and in the NETinventory User Guide. The machine you choose 
to host the NETinventory servers must meet the following minimum 
requirements:

• Pentium II 300 MHz, 128 MB RAM
• 285 MB of free disk space (Microsoft Windows NT 4.0); 235 MB of 

free disk space (Windows 2000, Windows XP, or Windows Server 
2003)

• SVGA monitor that supports 256 or more colors with the display 
set to 800 x 600 or more pixels 

• Microsoft Windows NT 4.0 SP6a Server or Windows 2000 (Server 
or Professional), Windows XP (Professional), or Windows Server 
2003 installed

• Internet Explorer 5.5 or later
• MDAC 2.6 or later is required on the server that will host the 

NETinventory SQL Server for SQL rollup
• Novell Client 4.8.3 SP1 or later (only required if there are 

NetWare Audit Servers)

If you will be using the NETinventory Snap-in for the BindView RMS 
Console, you will roll up NETinventory to a Microsoft SQL Server™ 
database. The machine that hosts the SQL database must have 
Microsoft SQL Server (7.0 or later) or Microsoft SQL Server Desktop 
Engine (MSDE) (1.0 or 2000). The machine hosting the Microsoft 
SQL Server can be the Master Server or any other server. 
1: Installing NETinventory 15
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About NETinventory Console Setup Types
MSDE data storage is suitable for networks with up to 10,000 
nodes. If you have more nodes, you should use Microsoft SQL 
Server to store the NETinventory SQL Database. In addition, if you 
will have more than 4 clients (BindView Information Servers or SQL 
Clients) accessing the NETinventory data, you should use Microsoft 
SQL Server. 

NETinventory Client 
Software Requirements

Nodes on your enterprise network are normally audited by 
NETinventory when they run the NETinventory Audit Agent, which is 
normally stored on a server designated as a Login Server. 
Therefore, nodes must have network client software installed. The 
client software needed depends on the operating system used by 
the client and on what type of NETinventory Audit and Login Server 
the nodes will communicate with. 

The NETinventory Audit Agent supports clients running DOS 
versions 6.2 and later; Windows 3.1 and 3.11; Windows 95; 
Windows 98; Windows Me®; Windows NT 3.51 and 4.0; Windows 
2000; Windows XP; and Windows Server 2003. 

• TCP/IP or IPX/SPX protocol
• Microsoft or Novell client software

You can use the Novell Client 32 on all client platforms. On Windows 
95, Windows 98, Windows NT 4.0. Windows 2000, Windows Me, 
Windows XP, and Windows Server 2003 clients, you can use 
Microsoft’s Requester software. 

The machine the NETinventory Console runs on while installing and 
managing the NETinventory server software must use Windows NT 
4.0 with Service Pack 6a, Windows 2000, Windows XP, or Windows 
Server 2003. 

About NETinventory 
Console Setup Types

The NETinventory Console can be installed in two ways:

• Program and shared files installed locally.
• Program files installed locally, shared files on a network drive. 

Each setup type has advantages and disadvantages, and your 
choice depends on your needs. If you aren’t sure which one to pick, 
you can change to a different type later by removing and 
reinstalling. 

Local Setup The Local setup type hosts all of the BindView files on your local 
hard drive, and is the fastest installation. The local installation 
makes it more difficult to share queries you have created with other 
users. In addition, the local installation requires the most free space 
on your local hard drive.

Combination Setup The Combination setup type stores files on the network and the 
local machine. Like the Local Setup Type, the BindView application 
files are stored on the local hard drive for speed. Certain shared 
databases are stored on a network volume. This makes the 
Combination setup somewhat slower than the Local setup, but it is 
easier to share queries among multiple users. 
16 NETinventory Console Getting Started Guide
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NETinventory Installation
Choosing the Setup 
Type to Use

If you are the only user of the NETinventory Console, and if you will 
only be using the NETinventory Console from a single computer, 
you should perform a Local setup. If more than one user will use the 
NETinventory Console, or if you will use the NETinventory Console 
from more than one computer, you should choose the Combination 
setup type. 

NETinventory 
Installation

NETinventory is shipped on a CD-ROM. 

You must install the NETinventory Console. If you choose, you can 
also install the NETinventory Snap-in for the BindView RMS Console. 

To start the NETinventory install programs

1 Insert the NETinventory CD-ROM into your CD-ROM drive.

2 If you have your computer set to automatically run inserted 
CDs, the NETinventory Install panel starts. If it does not, 
choose Start>Run and type the letter of your CD-ROM drive 
and SETUP.EXE, then click OK or press Enter. The Install panel 
appears.

Fig. 1 NETinventory Install Panel
1: Installing NETinventory 17
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NETinventory Installation
3 Click Install. The Select a Component panel appears. 

Fig. 2 NETinventory Install Panel - Select a Component 
Panel

To install the NETinventory Console

1 Click NETinventory Console to start the NETinventory 
Console installer. The Welcome panel appears. Click Next. 

Fig. 3 NETinventory Installer - Welcome Panel
18 NETinventory Console Getting Started Guide
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NETinventory Installation
2 The BindView License Agreement panel appears.

Fig. 4 NETinventory Installer - BindView License Agreement 
Panel

3 Read the License Agreement and click Yes to accept the terms 
of the agreement. 

The Setup Type panel appears. 

Fig. 5 NETinventory Installer - Setup Type Panel

4 In the Setup Type panel, select the appropriate setup type and 
click Next. 
1: Installing NETinventory 19
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NETinventory Installation
The appropriate Select Destination Directory panel appears. 

Fig. 6 NETinventory Installer - Select Local Destination 
Directory Panel (for Local Install)

Or 

Fig. 7 NETinventory Installer - Select Combination 
Destination Directory Panel (for Combination Install)

5 In the Select Destination Directory panel click Browse to 
select directories for the program and shared files, or leave the 
default installation location selected. 

Note: You should normally use the default installation location. 
20 NETinventory Console Getting Started Guide
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NETinventory Installation
Click Next.The Setup Wizard’s Select Components panel 
appears. 

Fig. 8 NETinventory Installer - Select Components Panel

6 Select the components to install. Click Next. 

If you chose to install the NETinventory sample data, the 
Select Destination Directory for Sample Files panel 
appears. 

Fig. 9 NETinventory Installer - Select Destination Directory 
for Sample Files Panel

7 Use Browse to select an appropriate directory, or use the 
default provided, and click Next.

Sample data should usually be stored in the same folder as the 
NETinventory Console or in a shared location so many 
workstations can access it. The sample data is read-only and 
cannot be modified.
1: Installing NETinventory 21
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NETinventory Installation
The Select Program Folder panel appears. 

Fig. 10 NETinventory Installer - Select Program Folder Panel

8 Select an existing program folder or enter a new program folder 
name in the Program Folders field, and click Next. If the 
wizard determines that system files need to be updated, the 
System Files Which Need Updating panel appears. 

Fig. 11 NETinventory Installer - System Files Which Need 
Updating Panel

9 To add the files, click Next. The wizard will copy NETinventory 
Console files to your computer. 

10 When finished copying files, the Setup Wizard will scan your 
machine for a valid Time Zone (TZ) environment variable. If it 
finds one, it will give you the option to change it. Generally, you 
do not need to make changes to a valid Time Zone variable. 
Click No if your machine already has a valid Time Zone 
variable. If you do make changes to the Time Zone variable, 
you will need to reboot your computer for the change to take 
effect. 
22 NETinventory Console Getting Started Guide

© 2004 BindView Corporation. All Rights Reserved



NETinventory Installation
If the Wizard does not find a Time Zone variable, it will prompt 
you to set a Time Zone environment variable. Click Next 

The Setup Wizard’s Setup Module Licenses panel appears.

Fig. 12 NETinventory Installer - Setup Module Licenses Panel

11 To add NETinventory Console licenses, select Add new 
licenses for the NETinventory Console and click Next. 

NETinventory Console Licenses are separate from the BindView 
RMS Console licenses. 

If you do not add licenses during the installation process, you 
must use the NETinventory Console to add them before you can 
collect and analyze any data from your enterprise network. 

The Setup Wizard’s Readme Files panel appears. 

Fig. 13 NETinventory Installer - Readme Files Panel

12 Select Readme documents to read, then click Next or Finish.

13 If you needed to make a change to your Time Zone (TZ) 
variable, you will be prompted to reboot your computer before 
using the NETinventory Console
1: Installing NETinventory 23
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NETinventory Installation
If you chose to view any of the Readme files, they are opened 
on the desktop.

To add NETinventory Console licenses

If you chose to add licenses on the Setup Wizard’s Setup 
Module Licenses panel, the BindView License Manager 
appears once the installation is complete. 

1 Click Add.

2 Type a license key from the license card in your NETinventory 
package. 

3 Click OK to add the license to the database. 

A single license is added. Repeat for each NETinventory license.

4 If you received the NETinventory licenses on a disk, insert the 
disk containing the licenses and click Have Disk. 

5 Click OK to add the licenses. All the NETinventory licenses on 
the disk will be installed. 

6 Click Done to close the BindView License Manager.

To install the NETinventory snap-in for the BindView 
RMS console

Before you install the NETinventory snap-in for the BindView RMS 
Console (NETinventory-RMS), you must install the BindView RMS 
Console and Information Server. If you have not already installed 
the BindView RMS Console, please consult the BindView RMS 
Console and Information Server User Guide for information on 
installing the console. 

1 If it is running, bring the NETinventory Install panel to the 
foreground by selecting it from the taskbar. If it is not running, 
start it. 
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NETinventory Installation
2 On the installation page of the Install panel, click 
NETinventory RMS Snap-in. The Welcome panel of the 
NETinventory-RMS installer appears. Click Next. 

Fig. 14 NETinventory-RMS Installer - Welcome Panel

3 The Software License Agreement panel appears. Read the 
License Agreement and click Yes to accept the terms. The 
Start Copying Files panel appears. 

4 Click Next, and the NETinventory-RMS files will be copied to 
your computer. When the installation is complete, the Setup 
Complete panel appears. 

Fig. 15 NETinventory-RMS Installer - Setup Complete Panel
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NETinventory Installation
5 Select Launch BindView RMS Console to start the console; 
select View Release Notes to view the NETinventory release 
notes. Click Finish to close the wizard. 

Note: You will not be able to retrieve NETinventory information 
using the NETinventory-RMS snap-in until you have configured the 
NETinventory Console, installed NETinventory servers, configured 
SQL rollup, audited nodes, and at least one synchronization has 
taken place. You must use the NETinventory Console to configure 
NETinventory and deploy servers. 
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© 2004 BindView Corporation. All Rights Reserved



2 NETinventory Setup

In This Chapter Overview.................................................................. 28
NETinventory Server Components................................ 28

Server Types......................................................... 29
Audit Agents and Windows NT Servers...................... 32

Using Existing Reporting Items .................................... 33
2: NETinventory Setup 27

© 2004 BindView Corporation. All Rights Reserved



Overview
Overview Once you have installed the NETinventory Console you can:

• Use the NETinventory Console to view data in the sample 
database and explore using the NETinventory Console. 

• Deploy and configure NETinventory servers and begin 
NETinventory data collection from your enterprise network.

Once NETinventory and its servers are installed, NETinventory 
collects information you specify from workstations on the network. 
You can use the NETinventory Console to view the data collected in 
a variety of formats. 

This chapter describes the NETinventory server components, and 
describes deploying the required NETinventory components.

Running the 
NETinventory 
Console 

To run the NETinventory Console, select the NETinventory Console 
item in the Start menu. By default, the item is created in the 
“BindView” Start Menu folder. 

The console starts and prompts for a password. One NETinventory 
Console user account exists by default. The User Name for the 
account is BV Admin. The BV Admin account has no password until 
you set one. See the “Configuring NETinventory Console Users” 
chapter of the NETinventory User Guide for information on setting 
and using console passwords.

User Names and Passwords in the NETinventory Console and user 
accounts in the BindView RMS Console are not related. You must 
create the accounts separately in each of the consoles. 

You must use the NETinventory Console to configure NETinventory 
and NETrc. You can then configure the NETinventory-RMS snap-in 
to retrieve NETinventory information. 

NETinventory 
Server 
Components

To set up NETinventory, you use the NETinventory New Enterprise 
Installation wizard to deploy and run a single NETinventory server 
on the network. The server will host one of each of the 
NETinventory server types: Master Server, Audit Server, and Login 
Server. 

After installing the NETinventory server components, use Windows 
administration tools to configure the server so that every user who 
logs in runs the NETinventory Audit Agent. This is the simplest 
NETinventory installation. For information on planning and installing 
in more complex situations, please see the “Setting Up 
NETinventory Server Components” chapter of the NETinventory 
User Guide. 

For instructions that guide you through every step of installing and 
configuring the NETinventory server components, please see the 
“Setting Up NETinventory Server Components” chapter of the 
NETinventory User Guide.
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Server Types To set up the NETinventory Console, you must select a single 
Windows NT 4.0 Server, Windows 2000, Windows XP, or Windows 
Server 2003 machine on your enterprise network to host the Master 
Server, Audit Server, and Login Server. You can select any machine 
on your network to host the NETinventory server. The machine you 
select should be running at all times so that nodes can contact it 
with audit data. 

Master Server The Master Server synchronizes the NETinventory databases 
maintained by the NETinventory servers. Your NETinventory 
enterprise should have only one Master Server. 

You must supply NETinventory with a user name and password it 
will use to configure the Master Server. This is called the Admin 
Account. 

The Admin Account can be a Domain or Workgroup account. If it is 
a Domain Account, it must be a member of the Domain 
Administrators group in the domain with the machine hosting the 
Master Server. When multiple NETinventory servers are hosted by 
the same computer, they all use the same Admin Account 
information. 

Audit Server Audit Servers collect and store audit information from nodes on 
your enterprise network. The Audit Agent running on nodes on the 
network communicate with the Audit Server to store audit data. 

The New Enterprise Installation Wizard installs an Audit Server on 
the same server that hosts your Master Server. The Master Server 
requires the presence of an Audit Server on the same computer in 
order to function properly, but that Audit Server does not need to 
be configured to store audit data for any nodes. Please see the 
NETinventory User Guide for information on assigning nodes to 
Audit Servers automatically. 

You can increase the audit speed by sharing the workload among 
multiple Audit Servers. You can install a separate Audit Server for 
specific network segments, or you can choose to install Audit 
Servers based on department functions or other groupings. 

The number of workstations a single Audit Server audits depends on 
the network load, the load on the server, the speed of the network, 
and how extensive the audit is. Begin by configuring one Audit 
Server for every 2000-3000 workstations that will be audited. You 
can then add or delete Audit Servers based on your network’s 
situation.

Initial audits require about 150 kilobytes per audited workstation. 
Over time, audit files may require as much as 1 megabyte per 
workstation. 

In addition to the Admin Account you supply for the NETinventory 
Console to communicate with the NETinventory servers, you can set 
up a separate Reporting Account. The NETinventory Console uses 
the Reporting Account to retrieve data from the Audit Server. 
Reporting Accounts allow users who can’t access a server to access 
audit data on the server. The Reporting Account is optional, and you 
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can create it when setting up the Audit Server, or you can add or 
change it later. 

For information on using additional Audit Servers or NetWare Audit 
Servers, or for step-by-step instructions on setting up an Audit 
Server, please see the “Setting Up NETinventory Server 
Components” chapter of the NETinventory User Guide.

Login Server Any machine hosting the NETinventory Audit Agent files are 
NETinventory Login Servers. Audit Agents are programs that run on 
workstations when they log in to the Login Server. The Audit Agent 
performs the work of auditing the workstation. 

Every server that workstations log in to should be a NETinventory 
Login Server. The Login Server does not require that any software 
or services run on the Login Server

For an audit to take place automatically, the Audit Agent should be 
executed when the workstation logs in to the Login Server. 

Server Requirements Any Windows NT 4.0 Server with Service Pack 6a, Windows 2000,, 
Windows XP, or Windows Server 2003 machine—server or 
workstation—can host the Master, Audit, and Login Server 
combination. Servers are normally running at all times, while 
workstations are very often rebooted, powered down, or otherwise 
unavailable. If you do choose to use a workstation, be sure that it 
will always be available when audits will be taking place. 

Needed Information During the installation, the wizard will prompt you for the following 
information:

• Name of the server that will host the NETinventory servers.
• Valid user name and password combination for the server. This 

account must be a Domain Admin account or a Local Admin 
account on the machine. You may wish to create a new user 
account for NETinventory to use.

• Valid NETinventory license code on disk or on a license card.
• Location on the machine where NETinventory files will be stored. 

This location must be a share. Every user who will use the 
NETinventory Console to report on the data must have access to 
this share. You should create this share before you begin 
installing the New Enterprise.

Optionally, you can supply NETinventory with a Reporting Account—
a Login name and password the NETinventory Console uses when it 
collects information from the Audit Server for display.

Automatic Installation The Wizard will prompt you to automatically install the Audit and 
Login Server you are creating. Since only one NETinventory server 
is being installed now, you should not use automatic install. 
Automatic Installation is useful when installing several Audit or 
Login Servers, since there is no wait time while the NETinventory 
Console copies files to each Server. 
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To set up a new NETinventory enterprise 

1 Insert the NETinventory Console CD-ROM, then run the 
NETinventory Console.

2 Select Options>NETinventory Setup. 

Fig. 16 NETinventory Setup Navigator Dialog

3 Click New Enterprise Installation.

The Install New Enterprise Dialog appears. Click Next to 
begin the installation. 

4 The Insert the NETinventory CD-ROM panel appears. 

Fig. 17 Insert the NETinventory CD-ROM Panel

5 If the path to the BindView directory is different from the path 
displayed in the dialog, click Browse.

The Locate the SITEDFLT Directory dialog appears. Locate 
the BINDVIEW directory, then locate the \NI\master\ directory 
and select it. Once you have selected the directory, click OK.
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Once you have selected the \NI\master\ directory in your 
BINDVIEW directory, click Next in the Insert CD dialog to 
begin the installation. 

The Wizard helps you install the new NETinventory enterprise. 

6 When the installation is complete, the New Enterprise panel 
will appear. Click Finish. The NETinventory Console will prompt 
you to configure SQL storage for data rolled up from the 
NETinventory enterprise. Rolling up data to SQL storage allows 
you to use the NETinventory snap-in for the BindView RMS 
Console to retrieve NETinventory data. To launch the SQL 
Settings wizard, click Yes, and the SQL Settings wizard will 
appear. For information on configuring data rollup, please see 
“Configuring the NETinventory Snap-in for the BindView RMS 
Console” on page 35. 

Audit Agents and 
Windows NT Servers

For a node to be audited, the node must run the Audit Agent, which 
does the actual work of auditing. There are several ways to ensure 
that nodes run the Audit Agent automatically. 

If individual user login scripts are enabled in your Windows-hosted 
Login Server’s User Manager, you should add the command 
bvaudit.exe to users’ login scripts. This process is easiest if 
multiple users share login scripts. If each user has a different login 
script, or if login scripts are not enabled, you can use policies to 
start the Audit Agent. 

If the server authenticating the user is not a NETinventory Login 
Server, you must either use the Login Script to map a drive to a 
share which contains the Audit Agent files and use the complete 
path for that share in the Login Script or use the UNC for the Audit 
Agent directory in the script. If the server authenticating the user is 
a NETinventory Login Server, the Audit Agent files should be in the 
NETLOGON$ share, and thus available to all users who authenticate 
to the server. 

System or group policies can be used to start the Audit Agent. For 
complete information on using System and Group policies, please 
consult your Windows documentation. 

To use policies, make sure that the directory replicator service is set 
up as specified in the Windows Server documentation. Then, use 
the System Policy Editor on a Domain Controller (DC) to add the 
Audit Agent’s Universal Naming Convention (UNC) path to the 
Default User’s Startup folder. After this is done, whenever a user 
logs into the domain, the Audit Agent will run. If a user only logs in 
to the local workstation without accessing network resources, the 
Agent will not run. 

Finally, you can add the command to run the Audit Agent to the 
node itself. On a DOS or Windows 3.1 node, add it to the node’s 
AUTOEXEC.BAT file. On a Windows 95, Windows 98, Windows ME, 
Windows NT, Windows 2000, Windows XP, or Windows Server 2003 
node, add the Audit Agent to the Startup folder in the Start menu. 
To prevent the icon from appearing in the Start menu, you can use 
the Windows Policy Editor to add it to the Startup group without an 
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icon appearing. You can also use a batch file and the Windows task 
scheduler to open the Audit Agent at a scheduled interval. This is 
particularly useful on a computer that is not logged into often, such 
as a server. 

Using Existing 
Reporting Items

The NETinventory Console includes many predefined report items 
you can use to analyze your enterprise network. Predefined reports 
give you examples of ways you can use NETinventory. In addition, 
you can use the items as a “head start” when creating your own 
reporting items. For information on creating reporting items, see 
the “Creating and Changing Items” chapter of the NETinventory 
User Guide. 

NETinventory can only display information that has been collected 
by its Audit Agents. If you have not yet audited any workstations, 
the NETinventory databases will not contain any information yet. 
You may need to wait until workstations have been audited before 
any query will display results. You can force workstations to be 
audited manually by running the Audit Agent. 

Report items have a Grid, Graph, or Folder icon.

Grid icons produce results that look something like those in 
spreadsheets. 

Graph icons produce graphs of your network resources. 

Folder icons represent folders of additional items. 

Double-click any grid or graph to run the query it contains. 

The NETinventory Console connects to your Audit Servers to collect 
and display the query data. You can print the results of a Grid or 
Graph.
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Overview
Overview The NETinventory Snap-in for the BindView RMS system allows you 
to use the BindView RMS Console to retrieve and display 
information collected by NETinventory. The BindView RMS Console 
includes data analysis features that the NETinventory Console does 
not include. In addition, it is easier to scale to large installations 
using the BindView RMS Console than it is to scale the NETinventory 
Console. 

When you use the NETinventory-RMS snap-in, the data collected 
from Audit Agents by the Audit Servers is rolled up to a SQL 
database by the Master Server. The NETinventory-RMS snap-in can 
then report on the data. 

When data is rolled up to the SQL database, you cannot perform 
ActiveAdmin® or other changes to the data, since the transfer to 
the SQL database is one-way. In addition, some data may be out-
of-date, since rollup only occurs when the Master Server 
synchronizes with the Audit Servers. For complete information on 
data rollup and on scheduling and controlling synchronization, 
please see the “Setting Up NETinventory Server Components” 
chapter of the NETinventory User Guide. 

Configuring SQL 
Rollup

When you configure SQL database rollup, you must specify the SQL 
server to store the data and the path on the server where the data 
should be stored. The following SQL server applications are 
supported for storing data:

• SQL Server 7.0 

• SQL Server 2000 (with and without named instances)

• MSDE 7.0

• MSDE 2000 (with and without named instances) 

Note: MSDE is required to use the BindView RMS Console and 
Information Server, and is included on the BindView RMS Console 
and Information Server installation disc. 

MSDE data storage is suitable for networks with up to 10,000 
nodes. If you have more nodes, you should use Microsoft SQL 
Server to store the NETinventory SQL Database. In addition, if you 
will have more than 4 clients (BindView Information Servers or SQL 
Clients) accessing the NETinventory data, you should use Microsoft 
SQL Server. 

To configure NETinventory SQL Settings

When you configure the NETinventory SQL settings, you must have 
permission to create and make changes to the SQL database that 
will store the NETinventory data. For information on configuring 
access to the SQL database, please see the User Guide for your SQL 
database. 
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Configuring SQL Rollup
1 Open the NETinventory SQL Database Configuration 
Wizard by clicking Yes when prompted to configure SQL 
settings in the New Enterprise Installation Wizard. 

Note: You can also configure SQL settings from within the 
NETinventory Console by choosing Options>NETinventory Setup, 
then clicking Server Setup and then SQL Settings. 

Fig. 18 NETinventory SQL Database Configuration Wizard

2 Click Next. The Select Operation panel appears. Since you 
have not yet created a SQL Database for this Master Server, 
the only option available is Configure a SQL Database for 
the Master Server. Click Next. The SQL Server and 
Database panel appears. 

Fig. 19 NETinventory SQL Database Configuration Wizard - 
SQL Server and Database Panel
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3 Enter the name of the SQL Server where data should be rolled 
up in the SQL Server Name field or choose the server’s name 
from the drop-down list. Click the browse (...) button or enter 
the path to the SQL database in the SQL Database Path field. 

Note: If the SQL Server you select is set up to use Windows 
Authentication, it must be in the same domain or in a trusted 
domain of the machine which hosts the BindView Information 
Server you will use to access the information. If there is not a trust 
relationship between the two domains, you must use SQL 
Authentication instead. 

4 Click Next. The Summary panel appears. 

5 Click Next. The Completing NETinventory SQL Database 
Configuration Wizard panel appears. Make sure that 
Perform Complete Database Synchronization now is 
selected and click Finish to create the database and roll the 
data up to it. 

An icon will appear in the System Tray on the Windows taskbar 
on the computer you use to enable SQL Rollup. When you 
double-click the icon, a dialog will appear allowing you to view 
the SQL Rollup status. 

Fig. 20 NETinventory SQL Configuration Status Dialog

In the future, new and changed data will be rolled up to the 
SQL server whenever the Master Server synchronizes the 
Enterprise network. 

Once you have audited nodes and a scheduled synchronization 
has taken place (by default, every hour), you will be able to use 
the NETinventory Snap-in for BindView RMS to retrieve 
NETinventory data from the SQL database. 

Note: The initial data rollup to SQL may take up to several hours, 
depending on your network configuration and how much 
NETinventory data has been collected already. 
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Using the 
NETinventory-RMS 
Snap-in

You must configure the BindView RMS Console and Information 
Server and the NETinventory-RMS snap-in before you can retrieve 
NETinventory information. 

The BindView RMS Console automatically detects when a new snap-
in is available to be configured and starts the BindView RMS Add 
Product Wizard when you run the BindView RMS Console. 

To configure the BindView RMS Console 

1 Open the BindView RMS Console. The simplest way to start the 
console is to select BindView RMS Console from the BindView 
RMS group in the Start menu. 

2 Follow the instructions in the BindView RMS Console 
Configuration wizard to add NETinventory-RMS to the Console, 
to add BindView RMS Console licenses if needed, and to create 
users. 

3 When the Wizard finishes, the BindView RMS Console appears. 

Fig. 21 BindView RMS Console 
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Using the NETinventory-RMS Snap-in
To configure the NETinventory-RMS snap-in

1 Select the NETinventory(Not Configured) item. The 
NETinventory configuration item appears. 

Fig. 22 BindView RMS Console with NETinventory (Not 
Configured) Node Selected

2 Double-click the <double-click to configure NETinventory 
Snap-in> item. The NETinventory Configuration Wizard 
appears. 

3 Follow the instructions in the NETinventory Configuration 
Wizard to configure NETinventory-RMS to access NETinventory 
data from your Master Server. 
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Using Existing 
Reporting Items

The NETinventory-RMS snap-in includes predefined report items 
you can use to analyze your network. Predefined reports give you 
examples of ways you can use NETinventory. In addition, you can 
use the items as a “head start” when creating your own reporting 
items. For information on creating reporting items, see the chapter 
“NETinventory Snap-in for BindView RMS” of the NETinventory User 
Guide. 

NETinventory can only display information that has been collected 
by Audit Agents and rolled up to the SQL databases. If you have not 
yet audited any workstations, the NETinventory databases will not 
contain any information yet. If audit data has not been rolled up to 
the SQL database, it will not be accessible using the BindView RMS 
Console. 

To use a pre-defined report item

1 Open the Risk Assessment and Control item in the BindView 
RMS Console.

2 Open the Pre-Defined folder. 

3 Open the NETinventory folder. 

4 Open the Getting Started folder. 

5 Double-click any item in the folder. The BindView RMS Console 
will retrieve the information specified in the query and display 
the information. 
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Overview
Overview Before you can use NETrc, you must install the NETinventory 
Console and deploy a NETinventory Master, Audit, and Login server. 
If you haven’t yet configured NETinventory servers, please see 
Chapter 2, “NETinventory Setup,” on page 27 for information on 
setting up NETinventory.

Once NETinventory and its servers are installed, with NETrc 
configured and the NETinventory audited nodes on your network, 
you can use NETrc and the NETinventory Console to take remote 
control of nodes which have been audited. 

For more detailed information on using NETrc, please see Section 4, 
“NETrc,” of the NETinventory User Guide. 

Configuring NETrc NETrc relies on NETinventory for essential services. Once you have 
set up your NETinventory enterprise network, you configure NETrc 
to install the NETrc Host on nodes as they are audited. Once the 
NETrc Host is installed, you can use the NETinventory Console to 
open the NETrc Viewer to view or control the audited nodes. 

Assigning Licenses NETrc licenses are based on the number of audited nodes. Every 
node which has the NETrc Host program installed must have a 
license. You do not enter a license code for each node. Instead, 
licenses are held by NETinventory Audit Servers and assigned to 
nodes when the Host software is installed. When the host is 
uninstalled, the license is returned to the pool. 

When you enter your NETrc license codes, the available licenses are 
held in a pool. To use the licenses, you assign them to the Audit 
Server on your network. 
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Assigning Licenses
To assign NETrc licenses to an Audit Server

1 Choose Options>NETrc Setup. The NETinventory Remote 
Control Setup dialog appears.

Fig. 23 NETinventory Remote Control Setup Dialog - General 
Setup Panel

2 Click Enterprise License Allocation. The NETrc Licenses 
Management panel appears. 

3 NETinventory Remote Control Setup Dialog - NETrc Licenses 
Management Panel
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Choosing a Default Profile
This page allows you to define how NETrc licenses are assigned 
to the Audit Servers on your network. The fields at the top of 
the page show how many licenses you have installed and how 
many are available for allocation. 

The lower portion of the page lists the Audit Servers on your 
network, along with how many licenses are assigned to each 
server and how many of the assigned licenses remain available 
for use. 

4 Click in the Assigned field for any audit server. Type the 
number of licenses to assign to the Audit Server, then press 
Enter. You can assign any number of licenses up to the number 
in the Available Pool field. 

5 If you have more than one Audit Server, you can assign 
licenses to additional servers. To remove licenses from a server 
and return them to the available pool, decrease the number in 
the Assigned field for that server. 

6 Click Apply to save the changes you have made. 

Choosing a Default 
Profile

Once licenses are assigned to Audit Servers, you can select a NETrc 
Profile to assign to audited nodes. 

To set a default NETrc profile 

1 Click General Setup. The General Setup panel appears. 

Fig. 24 NETinventory Remote Control Setup Dialog - General 
Setup Panel

2 Select Enable Remote Control for NETinventory Nodes.

3 Select a profile in the Default NETrc Profile for all Nodes 
field.
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The NETrc profile you choose will be assigned to all new nodes 
audited by the NETinventory Audit Agent. For nodes that have 
already been audited by the NETinventory Audit Agent, use the 
NETrc panel in the NETinventory Node Manager to manually 
assign a profile to the node. 

4 Click OK to close the NETinventory Remote Control Setup 
dialog and save the changes you have made. If you are 
prompted to allow NETinventory to synchronize servers, click 
OK to allow it to do so. 

Using NETrc All new nodes audited by NETinventory will have the default NETrc 
profile you selected assigned. Once nodes have been audited and 
they show up in a list of NETinventory nodes, you can use the 
NETinventory Node Manager to take control. 

Taking control with the Node Manager

1 Run any NETinventory Grid report and select a node from the 
grid. Double-click the node’s record in the grid and the 
NETinventory Node Manager appears. 

Fig. 25 NETinventory Node Manager - Overview Panel
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Using NETrc
2 Select NETrc in the column on the left side of the dialog. The 
NETrc panel appears.

Fig. 26 NETinventory Node Manager - NETrc Panel

3 Click Take Control, and the NETrc Master launches, allowing 
you to take control of the node. When you have finished, close 
the NETrc Master. 

4 When you have finished using the Node Manager, click OK or 
Cancel to close the Node Manager. 

Taking control with ActiveAdmin

You can also take control of any node with NETrc installed using 
ActiveAdmin. 

1 Run any NETinventory grid.

Fig. 27 NETinventory Grid 
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2 Click the node’s row number in the grid to select the node. 

Fig. 28 NETinventory Grid with row selected

3 Move the cursor over the selected row and right-click to display 
the pop-up menu. 

Fig. 29 NETinventory Grid with row selected and context 
menu

4 Select Take Control of this Node. The NETrc Master runs, 
allowing you to take control of the node. When you have 
finished, close the NETrc Master. 
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